
STRANGE COMMUNITIES 
Class schedule and Readings 

 
 
Thursday, August 21: 
Large Group: Opening Issues - The Joker, Mao Zedong, and Peter Berger 
 
 
Tuesday, August 26: 
Large Group: Motivations to Join a Gang 
Texts:  

 Glossary of social scientific terms (http://tinyurl.com/64dwcj) 
 Steven Levitt: Why do crack dealers still live with their moms? 

(http://tinyurl.com/69yz6q) 

Write in your Journal: Discuss motivations to join a gang, as presented in Levitt's talk. What do 
you conclude? In what ways do these motivations differ from motivations to join a profession, 
and in what ways are they similar? 
 
 
Thursday, August 28: 
Discussion groups: Applying Community Theory to an Urban Gang Setting 
Texts:  

 Venkatesh text, Foreward, Preface, Chapters 1-2 
 Smith's review of community theory (http://tinyurl.com/5kczwp) 

Write in your Journal: JT's mother, Ms. Mae, says (p. 43); "We live in a community, 
understand? Not the projects--I hate that word. We live in a community." Using ideas in Mark 
Smith's review of community theory, show how the Robert Taylor Homes locale is a 
community. 
 
Tuesday, September 2 
Large Group: Community Functions of the Gang 
Texts: 

 Venkatesh text, Chapters 3-5 

Write in your Journal: Some social scientific studies have abandoned the term "community" 
because it is too vague, concentrating instead on social networks (Smith article). Identify the 
social networking functions fulfilled by the Black Kings in the Robert Taylor homes. 

http://tinyurl.com/64dwcj
http://tinyurl.com/69yz6q
http://tinyurl.com/5kczwp


 
 
Thursday, September 4 
Discussion groups: Gangs, Insights Gained and the Limits of Participant Observation 
Texts: 

 Venkatesh text, Chapters 6-8 
 "Participant Observation and Informal Education" by Mark Smith 

(http://tinyurl.com/69oq3z) 

Write in your Journal: Using ideas in Smith's article, discuss the ethics of the four different 
modes of participant observation, particularly when studying illegal behavior. 
 
 
Tuesday, September 9 
Discussion groups: Your Responses 
Texts: 

 Interview with Sudhir Venkatesh (http://tinyurl.com/2j5ycv) 

Write in your Journal: Using a search engine such as Google, find a study of a street gang (other 
than Venkatesh's), summarize the main findings, and be prepared to talk about the differences 
and similarities to the Black Kings. 
Additionally: In the provided thread, post questions -- factual, analytic, interpretive -- that have 
been raised for you by the material on gangs so far. 
 
 
Thursday, September 11 
Large group: Living in Intentional Communities 
Texts: 

 An interview with Rick Scott and Allison Wallace about their experiences living in 
intentional communities 

Write in your Journal: Visit http://www.ic.org/ and identify at least three intentional 
communities you'd be interested in joining. Say why, and in so doing, name and discuss core 
values that you share with each community. 
 
Tuesday, September 16 
Discussion groups: Communal Action 
Texts: 

 "Using Theatrical Devices to Counter Culture" by Marcus Del Greco 
(http://tinyurl.com/5tog66) 

http://tinyurl.com/69oq3z
http://tinyurl.com/2j5ycv
http://www.ic.org/
http://tinyurl.com/5tog66


Write in your Journal: Write about the values and tactics of the Diggers in acting to engender 
social change. 
 
 
Thursday, September 18 
Discussion groups: Ways of Being in Intentional Communities 
Texts: 

 "Ends and Means: Communal Ideologies, Economics, and Organization" by Timothy 
Miller (eReader) 

Write in your Journal: Using Miller's article, describe the communities in which Rick and Allison 
lived, highlighting similarities and differences. 
 
 
Tuesday, September 23 
Large Group: Monks Introduction 
Texts: 

 Dunn Chapters 1-3 

Write in your Journal: Surely it is not coincidental that the desert was the location for the first 
Christian ascetics. Explain in your own words the logic behind Christians adopting an ascetic 
lifestyle, using the characteristics of the desert as a metaphor or jumping-off point. Then 
explain to what extent the the later monastic communities share these same values while 
adopting somewhat different practices. 
 
 
Thursday, September 25 
Discussion groups: Monastic History, Monastic Theology 
Texts: 

 Dunn Chapters 4-5 
 CFCS: Into Great Silence, Monday 9/29 @ 7 pm 

Write in your Journal: To those of us formed by American Protestant concepts, the notions of 
grace, faith, and works that spur the theology of monasticism can be seem puzzling. Form at 
least three meaningful questions about the various understandings of the relationship between 
Christian salvation and human behavior, sparked by Chapter 4. Then do your best to work 
through to the kind of answers that sustain monastic lifestyles, using what you know (or can 
find out from others, including the Internet) and what you've read so far. 
 
 
Tuesday, September 30 

http://honors.uca.edu/hcol/eReader.php?


Large Group: The Life Of A Monastic Mystic 
Texts: 

 Teresa Chapters 1-4, 8-13 
 Dunn Chapter 6 

Write in your Journal: Using what you've learned about the purposes, values, and motivations 
behind monastic life, analyze Teresa's goals, values, and motivations in her spiritual quest. 
What drives her, and what opportunities and challenges does the monastic life present as a 
setting for those drives? 
 
 
Thursday, October 2 
Discussion groups: Withdrawal and Engagement in Religious Movements 
Texts: 

 Teresa Chapters 20-25 
 Timothy Miller, "Religious Movements In The United States: An Informal Introduction" 

(http://tinyurl.com/6daj6x) 

Write in your Journal: If Teresa were beginning her spiritual journey today, what communities 
might she be drawn to? Do you think she'd be more comfortable in a traditional or an emergent 
setting? Would she follow an existing spiritual path, or start a new one? 
Additionally: In the provided thread, post questions -- factual, analytic, interpretive -- that have 
been raised for you by the material on monastics so far. 
 
 
Tuesday, October 7 
Large Group: Your Responses 
Texts: 

 Teresa Chapters 37-40 
 Lawrence Iannocone, "Why Strict Churches Are Strong" (eReader) 

Write in your Journal: Iannocone's economic analysis challenges our common-sense notion 
that people always seek the path of least resistance. Apply his ideas to the monastic setting 
that we have been investigating. What dimensions of freedom and meaning are found in a 
more rigorous or separatist religious community that are not found as prominently in more 
mainstream communities? 
 
 
Thursday, October 9 
Discussion groups: Communities of Faithful Violence 
Texts: 

http://tinyurl.com/6daj6x
http://honors.uca.edu/hcol/eReader.php?


 Mark Juergensmeyer, "Armageddon in a Toyko Subway" (eReader) 
 MTV: Big Love, Monday 10/13 @ 3 pm 

Write in your Journal: Juergensmeyer is interested in uncovering the rationales that lead 
religious communities (and the individuals influenced by them) into violence. What led the Aum 
Shinrikyo group to perpetrate the subway attack -- beliefs? social organization? particular 
goals? Do all religious communities share a similar propensity or possibility for violence, or is 
there something different about Aum? Compare the use of violence described by 
Juergensmeyer to the threat and actuality of violence in gang life; what similarities and 
differences can you discern? 
 
 
Tuesday, October 14 
Discussion groups: "Be Ye In The World, But Not Of It" 
Texts: 

 Donna Bowman, "Big Love and the Mainstreaming of American Fundamentalism" 
(eReader) 

Write in your Journal: Big Love portrays people with disapproved beliefs and practices trying to 
live undercover, as it were, among those who disapprove of them. Compare the strategies used 
by the Hendricksons to bolster their religious commitment to those used by monastics and 
other separatist communities. What do the Hendricksons gain and lose by attempting this 
unusual compromise? 
 
 
Thursday, October 16: No class -- Fall Break 
 
Tuesday, October 21 
Large Group: Wikifolk intro 
Texts: 

 Tapscott text, Chapters 1-5 

Write in your journal: CHECK YOUR HCOL PRIVATE MESSAGES FOR INSTRUCTIONS FROM PHIL. 
Add a new page to the Little Rock Renaissance wiki (http://honors.uca.edu/wiki/), or edit/add 
to an existing page or pages. Any public knowledge you might have about Central Arkansas is 
likely fair game. Add about 1500 characters total. Provide links and a summary of what you 
added/edited in your journal. Now think about the following and be ready to discuss in class: 
The Butler Center for Arkansas Studies already supports an Encyclopedia of Arkansas History 
and Culture (http://encyclopediaofarkansas.net/), and Wikipedia has many entries on Little 
Rock. What’s the point of a separate, stand-alone wiki like this? Isn’t this just duplication 
(triplication) of effort?  
 

http://honors.uca.edu/hcol/eReader.php?
http://honors.uca.edu/hcol/eReader.php?
http://honors.uca.edu/wiki/
http://encyclopediaofarkansas.net/


 
Thursday, October 23 
Project organization 
 
Tuesday, October 28 
Discussion groups: The Wiki Way 
Texts: 

 Tapscott text, Chapters 6-11 (Chapter 11 ("Wikinomics Playbook") available online at 
http://tinyurl.com/5usjme) 

Write in your journal: Examine the Wikiproject:Arkansas portal page on Wikipedia located at 
http://en.wikipedia.org/wiki/Wikiped...oject_Arkansas, and the discussion (“talk”) page for the 
project group at http://tinyurl.com/6ccdlm. Drawing from your knowledge of the wiki way, 
what constructive advice might you offer to the leader of this group, a thirty-year-old classified 
advertising designer at the Arkansas Democrat-Gazette? 
 
Thursday, October 30 
Large Group: Second Life: A 3D Wiki 
Texts: 

 Ludlow text, Chapters 1-9 warning: chapters 4 & 9 contain strong/potentially disturbing 
sexual themes 

Write in your journal: Gaze deeply at the picture on page 213 of The Second Life Herald. What 
do you think of Peter Ludow/Urizenus Sklar? Is it possible to maintain journalistic integrity 
while publishing a paper out of the Church of Mephistopheles? Is Ludlow mistaking digital 
fantasy for real news? (What is the news value of reporting on the activities of gangs, trekkies, 
witches, pagans, and vampire avatars? What about virtual adulterers and pedophiles?)  
 
 
Tuesday, November 4 
Discussion groups: Exploring Second Life 
Texts: 

 Ludlow text, Chapters 10-13 

Ethnography Lab Hours for playing Second Life are: 
Monday - 4:15-5:15; 6:15-9:00 
Tuesday - 6:15-7:45 
Wednesday - 3:15-5:00; 6:30-9:00 
Thursday - 6:15-8:45 
Friday - 3:15-5:15; 6:15-8:15 
 

http://tinyurl.com/5usjme
http://en.wikipedia.org/wiki/Wikipedia:WikiProject_Arkansas
http://tinyurl.com/6ccdlm


Write in your journal: Teleport to Nexus Prime (http://tinyurl.com/5p6pvq), Greenies Home 
(http://tinyurl.com/2rbwjb), Scion City (http://tinyurl.com/5fqpc3), and Mystic Coffeehouse 
(http://tinyurl.com/5mthmn) on Second Life. Make an effort to talk to other avatars at each 
location, try the poseballs, and experiment in the sandbox at Nexus Prime. Jot down your 
observations of each location and reactions to other residents as you explore these strange 
communities. How did you get around? Did you spend more time flying or walking or 
teleporting)? Do these locations contain any items with no conceivable utility (like bathrooms 
or dining rooms)? Take a couple of pictures of yourself interacting with your surroundings and 
send them to pfrana@gmail.com. What images stuck with you the next day? From your 
personal experience is it safe to assume that the typical Second Life user is an anti-social 
housebound dweller who only logs into SL because he doesn’t have a First Life?  
Additionally: In the provided thread, post questions -- factual, analytic, interpretive -- that have 
been raised for you by the material on online communities so far. 
 
Thursday, November 6 
Large Group: Your Responses 
Texts: 

 Ludlow text, Chapters 14-18 

Write in your journal: Explain how Facebook is or is not like an online fantasy role-playing 
game.  
 
Tuesday, November 11 
Discussion groups: Worlds Colliding 
Texts: 

 Watch "The Joi of Warcraft" (http://tinyurl.com/6nclow) warning: brief simulated CGI 
sex 

 "Why Virtual Worlds Can Matter" by Douglas Thomas and John Seely Brown 
(http://tinyurl.com/6x3twg) 

Write in your journal: Could Second Life serve as a model for future communities or 
workspaces? Could it ever replace your operating system desktop of files and folders (why does 
the computer interface have to be an office cubicle)? Could it ever replace the workplace 
entirely? Could World of Warcraft become the Country Club of the 21st century? How powerful 
are guild management tools as a model for all work done online by diverse companies with 
multiple and potentially far-flung operations?  
Additionally: In the provided thread, one representative from each of the six project groups 
provides a brief (paragraph-length) description of the project being undertaken -- its 
motivations, its goals, its subject, its format. There is a thread for this assignment in each Virtual 
Classroom. Group representatives should post in their own Virtual Classroom; there is no need 
to cross-post in the other VCs. 
 

http://tinyurl.com/5p6pvq
http://tinyurl.com/2rbwjb
http://tinyurl.com/5fqpc3
http://tinyurl.com/5mthmn
mailto:pfrana@gmail.com
http://tinyurl.com/6nclow
http://tinyurl.com/6x3twg


Thursday, November 13 
Discussion groups: Virtual Religion 
Texts: 

 James Au, "Where Two or More are Gathered" (http://tinyurl.com/6egypo) 
 James Au, "The Sacred and the Profane" (http://tinyurl.com/5utymv) 

Write in your journal: Compare Au's observations to Laurence Iannacone's 1994 essay, "Why 

Strict Churches Are Strong." Can SL ever provide more than "cheap grace" with no demand for 

discipleship? 

 

 

Tuesday, November 18 

Project groups 

 

Thursday, November 20 

Project groups 

 

Tuesday, November 25 

Project groups 

 

Thursday, November 27: No class -- Thanksgiving holiday 

 

Tuesday, December 2 

Large Group: Presentations 

 

Thursday, December 4 

Large Group: Presentations 

 

Class Podcasting Instructions 

Each week one member from each of the three small groups 
will meet and record a five minute conversation related to 
some aspect of the week’s lecture and discussion. 

Conversations will be linked to the HCOL homepage as a 
regular site feature. This assignment represents 15% of your 

http://tinyurl.com/6egypo
http://tinyurl.com/5utymv


final grade so spend some time creating and editing a meaningful podcast. 

How to create an audio podcast script: 

Writing for podcasting is different than writing for print. You’re writing for the ear, not the eye. 
Listeners have to get it the first time around – they can’t go back and hear it again (unlike re-
reading a sentence in an online article). And while a reader may get up and come back to an 
article, a podcast listener who gets up may not come back. So you want to grab their attention 
and hold onto it for as long as possible. Writing for podcasting is also different than most forms 
of academic writing. You can loosen up a little. You can be less literary and more creative and 
personal.  

The place to start is usually the “anchor intro” - this is what the “host” says to introduce the 
podcast episode. An anchor intro quickly sets up your narrative and puts it in context, without 
giving away too much.  

Be conversational. Your conversation should sound as natural as possible, like you’re telling a 
story to a friend. This is not the same as trying to imitate spontaneous speech. Instead, this 
means writing in a style that sounds as relaxed as possible. Use phrases and words you 
normally use. When you read your narration aloud, do you sound like yourself?  

Be visual. Give your listeners a chance to imagine. Create a sense of scene. Avoid creating an 
episode that’s just a series of facts.  

Be concise. Long sentences loaded with ten-cent words and relative clauses usually don’t work 
too well in podcasts. Mix up your sentence structure. It’s surprisingly easy to fill five minutes of 
airtime - so don’t overwrite.  

   

Be energetic. Use the active voice. Use punchy verbs and contractions. Mind your tenses – 
don’t switch back and forth between past and present. Don’t ramble. 

Be experimental. Even the most straightforward podcast can have an unusual or memorable 
element in it.  

Be thoughtful. Try to go beyond just presenting the facts. Let your listeners know why your 
podcast episode matters. Is there a lesson to be learned, something to be taken away? 
Conversely, don’t turn this into “Deep Thoughts” with Jack Handey - just take it a step or two 
beyond pure description.1  

                                                           
1
 Adapted from “Writing a Radio Script” 

http://www.bsideradio.org/joomla/index.php?option=com_content&task=view&id=70&Itemid=31 



Instructions for podcasting:  

1. Make sure that your built in microphone is turned on.  

Go to Settings>Control Panel> Sounds and Audio Devices 

Click Voice tab>choose a voice recording device 

2. Download Audacity 1.2.6 software for your system at http://audacity.sourceforge.net/ 

3. Download and install the Lame MP3 Encoder for your system at 
http://lame.buanzo.com.ar/ 

4. Open Audacity. Create a project name. 

File>Save Project As 

5. Create a new audio track. 

Project>New Audio Track 

6. Click the red circle record button to record your conversation. 

7. Click the pause button to pause recording, or the yellow square button to stop the 
recording. 

8. Save the recording track(s). 

File>Save Project 

9. Tracks can be copied, edited, or spliced together simply by highlighting portions of the 
track. 

10. Export tracks as MP3 files. 

File>Export as MP3 

The first time you do this the software will ask you to associate the program with the Lame MP3 
Encoder 

A popup box will ask you to write a basic description of the file 

11. Burn a copy and give it to Phil.  

http://audacity.sourceforge.net/
http://lame.buanzo.com.ar/


He will publish all of the podcasts at http://pfrana.podbean.com/ 

12. You can subscribe to the podcast by launching iTunes Launch. 

In the Advanced menu, select Subscribe to Podcast 

Enter the feed URL (http://pfrana.podbean.com/feed/) in the text box and click OK 

HOW TO PLAY SECOND LIFE 
 

 

Ethnography Lab Hours for playing Second Life are: 

 

Monday - 4:15-5:15; 6:15-9:00 

Tuesday - 6:15-7:45 

Wednesday - 3:15-5:00; 6:30-9:00 

Thursday - 6:15-8:45 

Friday - 3:15-5:15; 6:15-8:15 

 

Two machines on the wall opposite the door are marked as ready for you to play Second Life. 

Click on the desktop shortcut that looks like a teal hand:  

 

Getting Started: 

 

• Sign up for a Second Life account. (https://secondlife.com/join/) "Basic" level accounts are 

free! Be sure to choose a name you can be proud of; the name you choose during registration is 

the name by which other Residents in Second Life will identify you.  

 

• When you log in for the first time, you start on one of our many Help Islands. A simple tutorial 

appears in a corner of the Second Life viewer, and helps guide you through Second Life's many 

controls and features. Spending some time on Help Island learning how to use Second Life can 

prepare you for a much more rewarding Second Life experience.  

 

• If you've already left Help Island and you would like to go back, you may visit Help Island 

Public (https://support.secondlife.com/ics/s...uestionID=4250).  

 

• The most important skills in Second Life are Moving (use the ARROW keys), Flying (PAGE UP 

key, PAGE DOWN key), and Teleporting (click MAP button on screen>double click on map). 

 

http://pfrana.podbean.com/
http://pfrana.podbean.com/feed/
https://secondlife.com/join/
https://support.secondlife.com/ics/support/KBAnswer.asp?questionID=4250


• If you get lost or confused while inworld, try asking someone for help. Many experienced 

Residents are happy to help new arrivals; everybody needs help at some time or another! The 

Second Life Mentor group in particular is dedicated to providing helpful advice to avatars in 

need. 

 

Journal Prompt:  

 

Teleport to Nexus Prime (http://tinyurl.com/5p6pvq), Greenies Home 

(http://tinyurl.com/2rbwjb), Scion City (http://tinyurl.com/5fqpc3), and Mystic Coffeehouse 

(http://tinyurl.com/5mthmn) on Second Life. Make an effort to talk to other avatars at each 

location if possible, try the poseballs (a poseball is a rounded colored sphere where you can sit, 

dance, whatever), and experiment in the sandbox (a location for building your own 3D models) 

at Nexus Prime. Jot down your observations of each location and reactions to other residents as 

you explore these strange communities. How did you get around? Did you spend more time 

flying or walking or teleporting)? Do these locations contain any items with no conceivable 

utility (like bathrooms or dining rooms)?  

 

Take a couple of pictures of yourself interacting with your surroundings and send them to 

pfrana@gmail.com (click on Snapshot from the bottom menu or go to the top menu 

File>Snapshot). What images stuck with you the next day? From your personal experience is it 

safe to assume that the typical Second Life user is an anti-social housebound dweller who only 

logs into SL because he doesn’t have a First Life? Additionally: In the provided thread, post 

questions -- factual, analytic, interpretive -- that have been raised for you by the material on 

online communities so far. 

 

HELP ME!! 

 

How do I move around and fly? 

http://www.youtube.com/watch?v=EK2bczvyHoM 

 

How do I sit on things (including poseballs)? 

http://www.youtube.com/watch?v=j7lQKXZ8iIk 

 

How do I chat with other people? 

http://www.youtube.com/watch?v=thBdLhXkzEQ 

 

How do I customize my appearance? 

http://www.youtube.com/watch?v=Z4v6kK0ZKwE 

http://tinyurl.com/5p6pvq
http://tinyurl.com/2rbwjb
http://tinyurl.com/5fqpc3
http://tinyurl.com/5mthmn
mailto:pfrana@gmail.com
http://www.youtube.com/watch?v=EK2bczvyHoM
http://www.youtube.com/watch?v=j7lQKXZ8iIk
http://www.youtube.com/watch?v=thBdLhXkzEQ
http://www.youtube.com/watch?v=Z4v6kK0ZKwE


 

What is a Second Life Sandbox?? 

http://www.youtube.com/watch?v=b-JNQsI_KAI 

 

How can I take a Second Life Snapshot?? 

http://www.youtube.com/watch?v=prno9o9n2ic 

 

How do I use the camera controls? 

http://www.youtube.com/watch?v=1gDD13njjCE 

 

Why did the teleport locations listed in the assignment open up a webpage for SLurl? 

http://www.youtube.com/watch?v=ceIzvl0TYVc 

 

More Second Life Tutorials: 

http://secondlife.com/showcase/tutorials/ 

 

How to Play Second Life on Your Own Machine: 

 

• Take a look at the System Requirements (http://secondlife.com/support/sysreqs.php) and 

make sure your computer can run Second Life.  

 

• Sign up for a Second Life account. (https://secondlife.com/join/) "Basic" level accounts are 

free! Be sure to choose a name you can be proud of; the name you choose during registration is 

the name by which other Residents in Second Life will identify you.  

 

• Once you've checked the system requirements, download and install 

(http://www.secondlife.com/community/downloads.php) the Second Life viewer. Run the 

viewer to start exploring Second Life!  

 

• When you log in for the first time, you start on one of our many Help Islands. A simple tutorial 

appears in a corner of the Second Life viewer, and helps guide you through Second Life's many 

controls and features. Spending some time on Help Island learning how to use Second Life can 

prepare you for a much more rewarding Second Life experience.  

 

• If you've already left Help Island and you would like to go back, you may visit Help Island 

Public (https://support.secondlife.com/ics/s...uestionID=4250).  

 

• If you get lost or confused while inworld, try asking someone for help. Many experienced 

http://www.youtube.com/watch?v=b-JNQsI_KAI
http://www.youtube.com/watch?v=prno9o9n2ic
http://www.youtube.com/watch?v=1gDD13njjCE
http://www.youtube.com/watch?v=ceIzvl0TYVc
http://secondlife.com/showcase/tutorials/
http://secondlife.com/support/sysreqs.php
https://secondlife.com/join/
http://www.secondlife.com/community/downloads.php
https://support.secondlife.com/ics/support/KBAnswer.asp?questionID=4250


Residents are happy to help new arrivals; everybody needs help at some time or another! The 

Second Life Mentor group in particular is dedicated to providing helpful advice to those in need. 


